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Maya Software Help Guide

Installation

Maya is available for Microsoft Windows©. Official compatible versions are:
Windows© XP (Service Pack 2, Service Pack 3)

Windows®© Vista (32 - 64 bit ,Service Pack 1, Service Pack 2)

Windows© 7 (32 - 64 bit)

Maya is distributed as a *.exe self installing:

Maya_Install_<Version number >.exe

To install Maya you need to follow screen instructions:

e Create a new folder, rename it as MayaWorkspace inside Documents in Windows©
1. » Raccolte » Documenti » Documenti » MayaWorkspace » v | 45 N Cerca MayaWorkspace o

File Modifica Visualizza Strumenti ?

Organizza v [ Apii  Condividicon v  Postaelettronica  Masteriza  Nuova cartella = 0 @
7 Preferit % Raccolta Documenti el e
M Desktop MayaWorkspace
3 Documenti Nome Tipo Dimensione
18 Download
% Risorse recenti & Datalogger, Cartella di file
). DriverFTDI Cartella di file
4 Raccolte ). GP1_EVO Cartella di file
73 Documenti 4 Manual Cartella difile
1 Documenti )i Software 21/10/2013 09:11 Cartella di file
& Immagini
) MayaWorkspace
@ Musica
@ Video
)\ WebFontProjects
)i Documenti pubblici
& Immagini
& Musica
B Video

¥ Gruppo home
% Datalogger
Cartella di file
Ultima modifica: 21/10/2013 09:11

e Run Maya_Install_<Version number>.exe (double click) contained in Software in
MayaWorkspace folder.

e NOTE: Windows®© Vista and/or 7 could show some other permission requests. To
continue, chose Agree.

e Accept the user licence to proceed:
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Licenza d'uso
Prego leggere le condizioni della licenza d'uso prima di installare Maya Installer.

Premere Page Down per vedere il resto della licenza d'uso.

Maya is not regulated by a proper license agreement
and comes with 3 different access method:
Basic, Advanced and Professional

Maya is distributed as-is and is intended to be used

in conjunction with an Athena and/or Athena Evolution
device. Itis under users responsability to use Maya

to adjust Devices calibration according to their needs

Se si accettano i termini della licenza d'uso scegliere Accetto per continuare. E necessario
accettare i termini della licenza d'uso per installare Maya Installer.

Sistema di installazione Nullsoft v2.46

Selezione dei componenti
Selezionare i componenti di Maya Installer che si desidera installare.

Selezionare i componenti che si desidera installare.

Descrizione

Maya (required) Posizionare il puntatore
Visual Studio Redistributall -/ 0 e <

HASP key driver (requirec componente per

USB-Serial driver (optiona vederne la descrizione,

Spazio richiesto: 30.8MB

]

Sistema di installazione Nullsoft v2,46

[<Lndelro§15vmﬁ;]>[ Annulla ]

NOTE: if you are running the installation for the first time it is necessary to select all components.

If you are running an update it is possible to install only Maya
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e Chose installation path (or accept the default one — strongly suggested) and click Install to
start the installation process. During this process you could create a link to Desktop.

Scelta della cartella di installazione
Scegliere la cartella nella quale installare Maya Installer.

Questa procedura installera Maya Installer nella cartella sequente. Per installare in una
cartella diversa, selezionare Sfoglia e sceglierne un'altra. Per avviare l'installazione,
selezionare Installa.

Cartella di destinazione

Spazio richiesto: 30.8MB
Spazio disponibile: 76.2GB

Sistema di installazione Nullsoft v2,46
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Programming Cable Driver Installation

The following steps describe how to correctly configure the programming cable:

e Connect the programming cable to your USB port as in the picture

e Open the “Maya Diagnostic Tool” folder and click on “FTDI_setup”

@'@-| J » Computer » USBDISK(E} » Maya Diagnostic Tool » « [ #2 | [ Cerca Maya Diagnostic Tool o]

Organizza v Apri Masterizza Nuova cartella = ~ 0 O

o Musica *  MNome Ultima modifica Tipo Dimen

B video . o
Cucchi M . Device GM_SV_GT_440 19/07/2016 09:49 Cartella di file
it
R oGRS | Device_rs_sm_650_500_300 19/07/2016 03:49 Cartella di file
18 Computer R
& Disco tocale (€ | @ FTDLSetup 11/04/2016 15:19 Applicazione 16
isco locale (C: =
£ Unita DVD RW (D) (7 Maya_Install 0.10.0-betal 22/06/2016 11:52 Applicazione 258
nita . —
USB DISK (E3) T MU_Maya ENG 11/04/2016 15:20 Adobe Acrobat D... 125
-.L . T MU_Maya_rev10_ITA 11/04/2016 15:20 Adobe Acrobat D... 123
- bralpero

42,440

4. 3.5D650
4, R5 650
5.R5125
6.H26
CH3415ER
Maps I

m

HEE

Maya Diagnostic Tool
. R340

. usbdeview
BSD(R)

5 Experimental (\410.10.101.110) (G:)

FR Mo chee o AVIA AN AT T1A) LY

‘ FTDL Setup Ultima modifica: 11/04/2016 15:19 Data creazione: 28/07/2016 10:26

[ = ===

- 4 i, 3

Applicazione Dirmensione: 1,65 MB

2N
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Communication with the ECU

e Connect the programming cable to the diagnostic interface connector (behind the
front fairing in the RS/SM models or under the left side cover in the Silver Vase, Gran
Milano and Gran Turismo)

e DO NOT connect the jumper wire

e Turn the key in the "on” position (and lift up the side stand in the Silver Vase, Gran
Milano and Gran Turismo) -> you should hear the fuel pump turning
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e Click on File -> Preferences -> Communication and then click on the “Scan ports” icon

’Setup Maya -'
General | Communication | ElN] -.,.-im|

COmMS

Serial COM port

Acquisition refresh delay U

Comrmunication port delay 0

COM port baud rate [Use device default -

I

e Click on the Next button in the following windows
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This wizard will guide you to the selection
of the right port name to which the ECU is
connected. Follow the instructions in each

page.

Mow click "Mext” button

Select the type of connector you use on
your PC. It can be a physical RS232 line
or a USB to serial converter.

Select the port type and then click the
"Mext" button

Port type
@ USB () Serial

<Back | | Net> || Cancel
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MNow verify the following points:
1. Connect the ECU to the right port

2. Connect the ECL power and
ensure it is on

3. Click the "Mext" button

<Back | | Ned> || Cancel

«Click on the Finish button. If the connection is ok, you'll receive a message telling you the COM

port on which the ECU was found:

1 ECU found on port COMS.

Click on "Finish" button to store the
value and you will be ready to work with
the ECU.
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In the Silver Vase, Gran Milano and Gran Turismo you will receive the message “No ECU found” and
you have to select the last COM port available in the drop down list in the Communication settings

(see the picture below):

Setup Maya E
General | Communication |3[} -.,.-'.ew|
) COMS =
Serial COM port oL
P E ey

COomMl
Acquisition refresh delay COM3
COM4

Communication port delay 0

(<[l

COM port baud rate [Ll-se device default V]

| ook | [ Cancel

e If there is a connection problem you'll receive an error like the one in the following

picture:
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' Serial port detection wizard e
Error during port scan.
Error code: 0

Mumber of devices seen: 0

Go back and ensure you followed the
procedure correctly.

[ R ][ Einish ][ Cancel

In this case you need to check the procedure (installation of the programming cable’s
driver, key on, presence of power, kill switch in open position, ecc...)

Downloading Map to ECU

To download a map to the ECU the Maya software and the programming cable have to be
correctly installed and configured.

First open Maya software then choose the corresponding device of the bike you need to map:

e If you are mapping a RS/SM 650 — RS/SM 500 — RS300 you need to load the device in the
“Device_rs_sm_650_500_300" folder (inside the “Maya Diagnositc Tool" folder)

e If you are mapping a Silver Vase 440 — Gran Milano 440 — Gran Turismo 440 you need to
load the device in the "Device_GM_SV_GT_440" folder (inside the "Maya Diagnositc Tool"
folder)

To load the device:

e Click on “File” -> "Open Device"” -> then open the device folder and choose the file
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Layout License

Help

2

@

Open Device Descriptor

%

Device:

Addresses
@ Map 20

[ Map £1
..JF] PASSWORD

i P75 WIM-1M04-C04-F26

A G > @ DG B C

ﬁm"ﬁ f'i%n: ’i’
Device Helper

This is the help for explaining the
features of device elements

'| .o#= USB DISK (E:) » Maya Diagnostic Tool »

- | 3 | | Cerca Maya Diagniostic Tool

o]

Organizza v

Muova cartella

= 0 @

B Video
A Cucchi Matteo
1M Computer
E Disco locale (C
<2 Unita DVD RW
== USB DISK (E)
B SD(F)
¥ Bxperimental ()
58 Electronic (W10
Lg# Scambio (W10,
5 SWM (10101
5# ArchivioPdf (\\
5 Experimental {4
. BOM

-

F

MNome

1 Device_GM_SV_GT_440

Ultima modifica

19/07 /2016 09:49

Tipo

Cartella di file

I . Device_rs_sm_650_500_300

19/07/2016 09:49

Cartellz di file

Tipo - Cartella di file

Uttima medifica - 19/07/2016 09:49

Dimensioni 342 KB

File: IPTSWM_MO4CO4F32 001

v{l

| F

MNome file:

¥ ’Ma)ra Device Descriptor (*.mya] v]

I Apri

| | annuia ]

30/08/2017
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. Select a file -5
%!ﬂ . <« Maya Diagnostic ... » Device_rs_sm_850_500_300 - |4¢ | | Cerca Device rs_sm 650 500 3.. P |

Organizza « Muova cartella = » [ @

-

B video “ Mome Ultima medifica Tipo
A Cucchi Matteo
1M Computer

ﬂ Disco locale (C

2 Unita DVD RW

o USE DISK (E:)

%3 SD (F)

¥ Experimental (\

¥ Electronic (W10 E

g Scambio (W00

E SWM (10100

S8 ArchivioPdf (\\

L9 Experimental
L BOM

-

| A JPTSWM_MO4C04F32_r001 27/05/2016 11:21 Maya Device file

- 4| 1 | 3

Mome file:  JPTSWM_MO4C04F32_rD01 - ’Maya Device Descriptor (*.mya] V]

([ Apri D[ Annulla ]

To download the map to the ECU there are two different procedures in case the bike you are
mapping is a RS/SM 650 — RS/SM 500 — RS300 or a Silver Vase 440 — Gran Milano 440 — Gran
Turismo 440:

RS/SM 650 — RS/SM 500 - RS300 procedure:

e Connect the programming cable in the interface connector and follow the
“Communication with ECU" procedure

e When Maya find the ECU’s COM port, turn the key in the off position

e Connect the jumper wire:
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o Right click on “Map0” in Maya -> Open

A Maya 0.100-betal Evo - Map #0 ==Een

File Communication Tools Corrections Acquisition Layout License Help

P aE 88 "QL. > OO

Device: JPTSWM_M04C04F32_r001.mya Device Help
= JPTSWM-MO4-C04-F32
Addresses

Map #
L5 Passw Save as..
Read from ECU

Open...

Edit scalars...

Edit MNote...
View Info

View History

o Search the "Maps” folder under the “Maya Diagnostic Tool” folder
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Organizza v = Apri Condividi con = Masterizza
4l Raccolte =
@ Documenti
(| Immagini
J? Musica
B2 video
2 Cucchi Matteo
. Computer
& Disco locale ()
<2 Unita DVD RW (D:)
& USB DISK (E)
\. 1. Bialbero
L 2.440
J 3.5D 650
1 4.R5650
i 5.R5125
| 6.H26
i CH3415ER
.. Maya Diagnostic Tool
. R340

) usbdeview

@ oo

il Maps
,S 1!

m

o

Ultima modifica: 19/07/2016 09:49
Cartella di file

®v| .. » Computer » USBDISK (E:) » Maya Diagnostic Tool »

4|

MNuova cartella

Nome Ultima modifica

| Device_GM_SV_GT_440

. Device_rs_sm_650_500_300
@ FTDI Setup

(3} Maya_Install_0.10.0-betal
I MU_Maya_ENG

T MU_Maya_rev10_ITA

19/07/2016 09:49
19/07/2016 09:49
11,/04/2016 15:19
22/06/2016 11:52
11/04/2016 15:20
11/04/2016 15:20

- | g | | Cerca Maya Diagnostic Tool

E=mEeE X
L]
=~ 0 @

Tipo Dimen
Cartella difile
Cartella difile

Applicazione 1.6

Applicazione 25.6

Adobe Acrobat D... 121

Adobe Acrobat D... 12.]

| | Maps 19/07/2016 09:49

Cartella difile

I

o Open the bike model's folder you need (e.g. RS-SM 500)

. Select 2 file @
%v . ¢ Maya Diagnostic Tool » Maps » - | $,| | Cerca Maps o |
Organizza » MNuowva cartella 3= o+ [l @

B Desktop * Mome . Ultima modifica Tipo
4 Download — T
L 300 9kW 19/07/2016 09:49 Cartella di file
& OneDrive - SWM o
3 1, 300_Full_Power 19/07/2016 09:49 Cartella di file
1= Risorse recenti i e
o 440_GM_SV_GT 19/07/2016 (09:49 Cartella di file
. rs-sm_500 19/07/2016 09:49 Cartella di file
= Desktop —
: = . rs-sm_@B50 19/07/2016 09:49 Cartella di file
73 Raccolte
@ Dacumenti
[E=| Immagini
J’ Musica
B Video B
2 Cucchi Matteo
18 Computer
?ﬂ Rete - 4| 1 | F
Mome file: - [Ma],ra Maps (*.myp) v]
[ Apri ] ’ Annulla l
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° Load the “_Map0" file
'| 1o« Maya Diagnostic Tool » Maps » rs-sm_500 - | +3 | | Cerca rs-sm 500 o |
Organizza * Muova cartella Bz = @
Bl Desktop * Mome B Ultima modifica Tipo
it Download - 5 :
. &= SWM500_RS-5M 5 _Mapl 27/05/2016 10:34 File MYP
& Onelrive - SWM == ;
e : &= SWMS00_RS-5M 5a_Map0 05/05/2016 15:21 File MYP
“Cl Risorse recenti
B Desktop
i Raccolte 3
@ Documenti
[E| Immagini
J'! Musica
B video L
B Cucchi Matteo
L Computer
€
: — v 4 1 | r
Mome file:  SWIM500_RS-5M_5a_Mapd - [Ma:-ra Maps (*.myp) "l
I Apri I [ Annulla ]
o Follow the same proceure to load the “_Map1l” file in Maya
. Click on the "Download Map to ECU" icon
| Fi Communication [Tools Corrections Acquisition Layout License Help
LY ¥ AT Jme_ b @ E G O C
— Device Helper
= r oo i
(B Packet —
~{F] PASSWORD
30/08/2017
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Silver Vase 440 - Gran Milano 440 - Gran Turismo 440:

e Connect the programming cable in the interface connector and follow the

Maya Software Help Guide

"Communication with ECU" procedure
e When Maya find the ECU’s COM port, turn the key in the off position
e DO NOT Connect the jumper wire
e Right click on "Application”

& Maya 010.0-betal Evo - Map 1

File Communication Tools Corrections Acquisition

Layout License Help

==

B = E 3

Device: MEZSWM_M43C20F44_r02_GET15.m.

=

MB25SWIM-M43-C20-F44-GET15
- Addresses
5
-4 Map1
- Packet

2 4R Ir@ EHOC

Device Help

e Open -> Select the "APC" file in the bike model’s folder (under the “Maps” folder in the
“Maya Diagnostic Tool”, e.g. Gran Milano as in the picture below)

A seectafile

=

Organizza +
B Desktop -
& Download
‘& OneDrive - SWM

am :
LE]
=| Risorse recenti

B Desktop
- Raccolte
@ Documenti
Immagini
J'i Musica

m

A Cucchi Matteo
Lo Computer
€ Rete

@_'O-| 1« Maps » 440_GM_SV_GT

Nuova cartella

B video B

[ 42| [ Cerca 440 GM 5v_GT ol
- A @
MNome ‘ Ultima modifica Tipo
ﬁi APC44_GranMilano_3 23/06/2016 15:30 File MYP
& APCA4 SilverVase 3 23/06/2016 15:30 File MYP
& CORE_MB25SWM44_440_GM_7 23/06/2016 15:30 File MYP
& CORE_MB25Wh44_440_5V_15 23/06/2016 15:30 File MYP

<

1

30/08/2017

Nome file: APC44_GranMilano_3

x [Ma:-fa Maps (*.myp)

5

[ Apri

I ’ Annulla ]

s

Right click on "“Mapl”
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_Ffile Communication Tools Corrections Acquisition Layout License Help

Packet

B MB2SWM-M43-C20-F44-GET15
: Addresses

2 Jtap 1]

==

AR @ DA OO

e Open -> Select the “"CORE" file in the bike model's folder (under the “Maps” folder in the
“Maya Diagnostic Tool”, e.g. Gran Milano as in the picture below)

v| |« Maps » 440_GM_SV_GT ~ | %2 || Cerca 240.6M sv_GT P
Organizza Muova cartella = 0 @
< Preferiti Mome . Ultima modifica Tipo

M Desktop iﬂ APC44_GranMilano_3 23/06/2016 15:30 File MYP
‘ Download Iﬂ APC44 SilverVase 3 23/06/2016 15:30 File MYP
% OneDrive - SWM | |&] CORE_MB25WM44 440_GM 7 23/06/2016 15:30 File MYP
“El Risorse recenti | _ | |:|\ CORE_MB2: : : E(2016 15:30 File MYP
= Tipo - File MYP
Dimensione - 13,7 KB
. Desktop Ultima modifica - 23,/06,2016 15:30
= Raccolte
Documenti
[E=| Immagini B
J‘ Musica
B video
A Cucchi Matteo
1% Computer -4 LI} g r
Nome file: CORE_MB2SWMA44_440_GM 7 - ’Maya Maps (*.myp) v]
I Apri I [ Annulla l
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. Click on the "Download Map to ECU" icon

Layout License Help

v [mep20 b’. .ﬁ 4@0

. | :
28
i Device Help
>
L Rpiiacas Device Helper
Map #0
= Mapﬁ This is the help for explaining the

ik b Eiet g features of device elements

- ac e

~{F] PASSWORD

TPS Calibration

Connect the programming cable to the interface connector and turn the key in the “on”
position (lift up the side stand for 440 models)

e Open Maya, load the device file of the bike model you're checking and follow the
“Communication with ECU" procedure

e Click on the "End of Line Settings” icon:

File Communication Tools Corrections Acquisition Layout License Help

P REE88 " ;@ O -*ﬁ\mac

Device: MB2SWM_M43C20F44_r02_GET15.m.. ﬁi Open End Of Line Setting Window

- MB2SWM-1M43-C20-F44-GET15
i Addresses
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e Click on the “Start Calibration Read” button with the throttle in full close position (zero
TPS):

IMAXPTV

PARK_OFFSET_1

PARK_OFFSET_2

_OFFSET_1

_OFFSET_2

LIMITER_AD)

S —
L Start Calibration Read D Stop Calibration Read
skt

—_—  —
T _—

e You will see that the number in the TPS1 box (in the up-right corner of the window)
starting to change. You have to put an average value of those you see, in the TPS_1_MIN
box, like in the picture below:
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e Fully open the throttle position and do the same procedure putting an average value of
those you see in the TPS_1_MAX box, like in the picture below:

Set End of Line

e Click on the "Stop Calibration Read" button and then to the "Set End of Line" button like in
the two following pictures:

el Enel of Line Eead Ervd of Lne
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|ISPARK_OFFSF[_1 -32,00 5 rlPSl 0,000
||]N.I_0FFSE[_1 0,00
||LTSA_MATRD( Matrix
||D.A\|" 0 |
IMONTH 0
IYEAR 0
ITPS_]_M]N 0 - |+
TPS_1_MAX 0 il
Start Calibration Read Stop Calibration Read

. <

SetEndofline ) [ Read End of Line ] Reset End of Line Close
e |

Checking Diagnostic

e Connect the programming cable to the interface connector and turn the key in the “on”

position (lift up the side stand for 440 models)

e Open Maya, load the device file of the bike model you're checking and follow the
“Communication with ECU" procedure

e Click on the "Open Diagnostic Window" icon:

File Communication Tools Coprections Acquisition Layout License Help

= B =

~ MB25WIM-M43-C20-F44-GET15

Addresses

Packet

8 AP ;@ B

QC
o Open diagnostics window

30/08/2017
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e Turn the key in the “on” position and then click on the "Read” button

Diagnosys OK —
No errors are stored

Diagnosys ERROR:
error is stored L4

Maya Software Help Guide

M Diagnostic Flags

Error Code Description Status
9 POL17 Engine Temperature Sensor Low Input  OK
9 POL1B Engine Temperature Sensor High Input K
r 9 POLZ2 TPS Low Input: [ TPS Short ko Ground CK
6 PO123 TPS High Input J TPS Open Circuit OK
Eposs2 System Yolage Too Low oK
€9 Poss3 System Yoltage Too High oK
@riz01 Injector 1 Malfunction oK
9 P1202 Injector 2 Malfunction QK
€poast Coil 1 Malfunction oK
9 POL12 Air Temperature Sensor Low Input OK
G PO113 &ir Temperature Sensor High Input ERROR

e If there are red lights press the “Reset” button and the “Read” again to check the actual
status of the ECU. it is possible that an error that is visualized in the error window is not
anymore seen by the ECU. The ECU in any case stores in its memory events occurred
during functioning, therefore in the diagnosis window the error is stored (false error).

M Diagnostic Flags

Error Code

©ro117
)rot1s
ro122
©ro123
) rose2
) Pose3
©r1201
r1202

) Po3st
ro112
ro113

30/08/2017

Description
Engine Temperature Sensor Low Input

oK

Engine Temperature Sensor High Input  OK

TPS Low Input [ TPS Short to Ground
TPS High Input j TPS Open Circuit
System Yoltage Too Low

System Yoltage Too High

Injector 1 Malfunction

Injector 2 Malfunction

Coil 1 Malfunction

Air Temperature Sensor Low Input
Air Temperature Sensor High Input

oK
OK
oK
oK
oK
oK
OK
oK
oK
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Checking Parameters

To open the engine functioning parameters’ window, click on “Layout” — "New Activity":

A Maya 0105 Pro - Map =X
Fle Communication Tools Corrections Acquisition [Layout | License Help

x é @‘6 4 [: New Activity... Ctrl+A . ®

New Window... Cri+N

Device: MB2SWN_NS1C20F53_r01_GET15.mya Device Help X
O MB2SWM-M51-C20-F53.GETLS Rename activity..  Ctrl+Shift+A

R Constants
- Addresses
: Import Layout...
- Mapl
[ Packet

]
"
ram

"

Save Layout.

®

&

Creste a new activity tab in the main window
ks

emipEE 00000000 rmnaw

Then click on "OK" button when the following window appears:

A Maya 0105

FileCommuni Tools _Corrections Acquisition _Layout License_Help

L= ===
X ERee *HL PO EEEHEHSMO
| Device: MB2SWW_MS1C20FS3_r01_GET1S mya
=] MB2SWM-M51-C20-F53-GET1S

@ Constants
& Addresses
G Application

Device Help x

Setup new activity ===}
g vty Name
) faci |
Layout type.
® Single ) 1+1 Vertical () 1+1 Horizontal
O1e2Vettical (O 2+1Vertical () 2+2Vertical
(©)1+2 Horizontal () 2+1 Horizontal (©) 2+2 Horizontal

oK Cancel

= 1349
T e @M% 00 ey
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Now click on “Open Scalar Display”:

KMo

File Communication Tools Comections Acquisition Layout License Help

A ERee " PO

Device: MB2SWM_M51C20F53_r01_GET15.mya
=] MB25WM-M51-C20-F53-GET15

Constants

Addresses

o

Activity L Device Help x

Open Matrix Here..

Open Vector Here...

Open Scalar Display Here...

Open Analog Display Here... ‘

Open Scope view Here... ‘

and then select the parameters in the scroll list:

& Maya 0,105 Pro - Map

File Communication Tools Corrections Acquisition Layout License Help

x‘é@“'*siﬂ 7EOL‘®

| Device: MB2SWH_W51C20F53_r01_GET15 mya i Activity1 X | || Device Help =
@ MB2SWM-MS1-C20-F53-GET15 F - =
- Constants
- Addresses
@ Application

-8 Map1
M- Packet
Open Mati Here... ‘
Display variables selectien =5
Please select a the variables to display

ERCOUNTER i ‘

[ Selectall I Unselect al ]

pr—
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Below you'll find the list of the most import parameters and for some of them, the normal values
that they assumed during engine functioning:

e RPM: Engine speed

e MAP: Mainfold Air Pressure

e BAP: Barometric Air Pressure

e BARO_FROM_MAP: Barometric Air Pressure obtained from the input of the MAP sensor

e K_LAMBDAL: O2 sensor correction on injection time. Usually is a value close to 1 and may
moves from 0,7 to 1,2. If you see a costant value of 0,6 or 1,3 there may be a problem on
the sensor or on the throttle body (see the decription of the MAP_BAP_RATIO parameter)

e INJ_1: Actual injection time on cylinder 1

e SPARK_1: Actual spark advance on cylinder 1

e PHASE_1: Actual injection angle before TDC

e LAMBDA_OFF_COUNT: Time interval after which the O2 sensor starts to work

e THROTTLE_16: Actual position of the ThrottleValve in % (must vary from a minimum value
of 0 to a maximum value of 100)

e AIR T: Actual intake air temperature in °C

o ENGINE_T: For water cooled engines is the actual water temperature in the engine cooling
jacket. For air cooled engines is the actual cylinder head temperature

e BATT_V1: Actual battery voltage (it should be around 12.5 V in key on and raise to 14 V
when the bike is running; on 440 classic models it should raise to 13.3 V with engine
running)

e GEAR: Actual gear used. When this value is 0 the Neutral indicator on the dashboard must
be active. On models with a Gear Poition Sensor (RS300, RS/SM500, RS650, SD650) it gives
every gear number. On RS/SM125 and 440 classic models it's only a neutral indicator

e STEPPER: Actual position of the stepper motor or of the idle solenoid valve. This values
should decrease when the engine starts to run from key on

e MAP_BAP_RATIO: It's the ratio of MAP and BAP values. It's calculated when the bike is kept
in idle and gives an information about the air flow when the throttle valve is in close
position. It's really important for the good working of the bike that it's value is close to the
ones in following list for each model:

MODEL MAP_BAP_RATIO
RS300 400
RS/SM 500 315
RS/SD 650 300
RS/SM 125 750
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OFFSET CHECKING:

Another important check to do is the offset check.

To do it click on the EOL settings window (as in the TPS calibration procedure) and go in the upper
side:

A Maya 0.105 Pro - Map L
File Communication Tools Corrections Acquisition Layout _License _Help

EElde "G b O DZHMO

Device: WB2SWN_N51C20F53_r01_GET15 mya Activiy L x| Device Help x
S MB2SWM-M51-C20-F53-GETL5 =
Constant:
- Addresses -
Ry % End of e parameters =R
W Map1 I -
i ’FPARK,GFFBEU 32,00 ﬁ ~ frest 0,000
< IINJ_OFFSET_l u,uuD = D
DLE_INTLEARN ol f =
iLTSM [ -
IVEHICLEJD’NUM -+
|CU5TMER,ID -+
IDAV L) (e
MONTH ﬂl,"+]'
Start Calibration Read Stop Calibration Read
Set End of Line Read End of Line Reset End of Line Close
Open Scope view Here...

MIL_ON_MASK_8 = 0 (Scalar)

2 c mNSE

08/06/2017

You'll find the 2 parameters SPARK_OFFSET_1, INJ_OFFSET_1

Their correct values should be respectively:

SPARK_OFFSET_1 = 0,00

INJ_OFFSET_1 = 0,00 (or eventually 1)

If you see a different value (like -32,00 in the image) you must change it to the correct one.
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If the software don't let you change the values please contact us.

This values are always checked by SWM during the EOL bike test, but in rare cases (especially on
440 Euro 3 classic models) they change when a voltage battery drop happens (full discharge of
battery or fuse break).
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